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Introduction
This chapter explains basic and necessary knowledge before using "Everio MediaBrowser".
Please read this chapter before operation. Also, please refer to the instruction maunal of your 
camcorder.
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About The Software Guide
This guide explains how to use "Everio MediaBrowser" (referred to as "MediaBrowser").

This guide does not mention basic operations of Windows Operating System. Menu selection 
and window operations are based on general operation procedures of Windows Operating 
System.

It is prohibited to reproduce the content of this guide, fully or partially, without notice.

The content of this guide may be modified without notice.

Please contact our User Support Center if you have any question.

Illustrations in this guide show screen captures of the software under development. They may 
be different from the actual software.

Symbols Used in This Guide
This guide uses the following symbols.

 This symbol indicates a reference page relating to the topics.

     This symbol indicates important notice for operations.

   This symbol indicates a useful hint for operations .

•

•
•
•
•
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Trademarks
MediaBrowser™ is a trademark of PIXELA CORPORATION.

Windows® is a registered trademark of Microsoft Corporation in the U.S.A. and other 
countries.

The official name of Windows is Microsoft® Windows®.

Manufactured under license from Dolby Laboratories."Dolby" and the double-D symbol 
are trademarks of Dolby Laboratories.

iPod®, iTunes® are the trademarks of Apple Inc.

YouTube™ and "YouTube" logo are trademarks and registered trandemarks of YouTube 
LLC.

Google™ is the trademarks of Google Inc.

The company names and brand names referred to in this instruction manual are them-
selves the trademarks, registered trademarks, and products of the respective compa-
nies.

The ® and ™ marks have been omitted in this instruction maual.

•
•

•
•

•
•

•
•

•
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Before Using MediaBrowser

Cautions
If recorded and/or edited content includes copyrighted works created by third parties, be 
sure to use them for personal use.

Use an AC adaptor for the notebook computer power supply.

Use an AC adaptor for the camcorder power supply.

Connect the camcorder and the computer directly with an USB cable. Operation using 
USB hubs is not guaranteed.

Do not put computer in Standby mode when a camcorder is connected.

You cannot overwrite recorded DVD-R, DVD+R, DVD-R DL and DVD+R DL discs. When 
using a rewritable disc, erase the recorded data with "MediaBrowser" before writing.

Do not to operate other software during disc writing.

About Supported Data
With "MediaBrowser", you can use videos recorded with a JVC camcorder with which 
"MediaBrowser" is bundled.

Audio files are not supported.

Operating Limitations
"MediaBrowser" does not support Unicode.

Even if video recordings are in a supported format, you may not be able to use them 
depending on the recording method.

You cannot use "MediaBrowser" when connecting two or more camcorders to the com-
puter.

•

•
•
•

•
•

•

•

•

•
•

•
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System folders, Windows-only folders, the root directory C:\ and optical drives cannot be 
selected as the saving destination for the Library and file export. For details about the 
Library, refer to P. 48.

You cannot add files to the Library by drag and drop in "Explorer" from removable disks. 
For details about the Library, refer to P. 48.

Exporting files after editing or converting with "MediaBrowser", the picture quality of the 
movie will be lower than the original.

Playback on all players is not supported for discs created with "MediaBrowser".

"MediaBrowser" may not operate correctly when a writing software other than "Medi-
aBrowser" is installed. In this case, we recommend not to use multiple disc writing soft-
ware at the same time.

When erasing data on a rewritable disc, the progress bar may not be displayed correctly 
in some drives.

Refer to the following website for the latest information about operating limitations.
http://www.pixela.co.jp/oem/jvc/e/

Supported Files

Importing

File format (extension)

Everio movie file (.mod)

MediaBrowser edit files (.mbv)

JPEG (.jpg)

Media type

Hard disk in the camcorder

SD Memory Card

•

•

•

•
•

•

•

♦

♦

http://www.pixela.co.jp/oem/jvc/e/
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Writing

File format (extension)

Movie edit: MBV (.mbv)

Still image: JPEG (.jpg)

For upload to YouTube, Movie conversion: WMV (.wmv)

For export to iTunes: M4V (.m4v)

Disc creation: DVD-Video

Disc type

DVD-R

DVD-R DL

DVD-RW

DVD+R

DVD+R DL

DVD+RW
8cm discs are not supported.

When using a rewritable disc, erase the recorded data with "MediaBrowser" before writing.

♦

♦

※

※
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Preparation

Starting and Exiting

Starting

You can start "MediaBrowser" in any of the following ways:

Connect the camcorder.
"MediaBrowser" starts automatically when the camcorder is connected and a menu item is selected.

Start from the shortcut icon.
Double-click the shortcut icon on the Desktop. 

Start from the [Start] menu.
Select the [Start] menu-[All Programs]-[PIXELA]-[Everio MediaBrowser]-[Everio MediaBrowser].

"MediaBrowser" browser screen will be displayed.

For details about Browser screen, refer to (P. 47).

Exiting

Click [  ] / [  ] on the upper right screen. 
Close all dialog boxes and setting screens before exiting.

•

•

•
➡

ォ

※

Windows VistaWindows XP Windows VistaWindows XP
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Connecting/Disconnecting the Camcorder
If the camcorder is disconnected from the computer while using "MediaBrowser", video files 
in the camcorder may be damaged. Follow the instructions below when disconnecting the 
camcorder from the computer.

Use an AC adaptor for the camcorder power supply.

Connect the camcorder and the computer with a USB cable. Operation using USB hub is 
not guaranteed.

When disconnecting USB cable, click "Safety remove USB Mass Storage Device" icon 
(  (XP) /  (Vista))to release camcorder connection.

Connecting the Camcorder

Connect camcorder to wall outlet using AC adaptor.

Turn on the camcorder.

Connect the camcorder and computer with a USB cable.

Selection screen appears on your camcorder.

Select a connection to computer in the menu of the camcorder screen.

"MediaBrowser" browser screen will be displayed.

For operations of camcorder, please refer to the camcorder instruction manual.

Disconnecting the Camcorder

Click [  ](XP) / [  ](Vista) on the lower right screen.

Click [Safely remove Mass Storage Device -Drive(X:)].

The letter that appears as "Drive (X:)" varies depending on the computer.
If multiple choices are displayed, select  the drive corresponding to the camcorder.

A message informing you it is safe to remove hardware will be displayed.

Disconnect camcorder.

•
•
•

⒈

⒉

⒊
➡

⒋
➡

ォ

⒈

⒉
※
※

➡

⒊
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What You Can Do with MediaBrowser
"MediaBrowser" expands the use of videos recorded with your camcorder.
You can just follow the instructions on the screen to use the functions.

Write on Discs

Save on the Computer

Export to iTunes

Upload to YouTube

Playback Videos

Manage Videos

Edit Videos

•
•
•
•
•
•
•

iTunes

YouTube

DVD

iTunes

YouTube

DVD



Using Videos Stored in 
Camcorder

You can write videos in the camcorder directly to a disc, or save videos to computer more easily 
by selecting menus on camcorder screen.
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What you can do with the camcorder connected
"MediaBrowser" expands the use of videos recorded with your camcorder.
You can just follow the instructions on the screen to use the functions.

Store Videos
Saving on a disc

Connect your camcorder and press [DIRECT DVD] on camcorder to create a DVD-Video disc with sim-
ple operation.

For details, refer to "Write Videos onto Discs"(P. 18).

Saving on the Computer
Save videos in computer and you can create DVD-Video discs and edit movies anytime.

For details, refer to "Save Videos to Computer"(P. 23).

•

ォ

•
ォ
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Convert Videos for iTunes or YouTube
You can walk around with the recorded videos on your iPod, or share them on YouTube.

Export to iTunes
Video data is converted for iPod and automatically added to "iTunes".

For details, refer to "Export Videos to iTunes"(P. 26).

Upload to YouTube
Enter "YouTube" account information, and converted videos can be uploaded automatically.

For details, refer to "Upload Videos to YouTube"(P. 30).

Playback Videos in the Camcorder
"What is this video...?" Preview function will help you check the videos in times like this.

You can play back the videos stored in the camcorder by connecting  your camcorder and the computer.

For details, refer to "Check Video Contents"(P. 34).

•
ォ

•

ォ

ォ

iTunes

YouTube

iTunes

YouTube
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Write Videos onto Discs

Writing All Videos onto Discs(Direct DVD)
Create DVD-Video disc that you can playback on a DVD player. Settings such as menu 
screen creation are done automatically and you can create DVD-Video discs without operat-
ing computer much.

Video files already written before with the direct DVD function will not be written.

Set a DVD to write to in the drive.

Close screens such as Explorer.

Connect the camcorder to the computer.

Press [DIRECT DVD] button on the camcorder.

"MediaBrowser" Direct Disc screen will be displayed and disc creation will be started.

If "Set a new disc" message appears, set a disc in a drive. Up to 5 discs can be created in one opera-
tion.

Created DVD can be played back on a DVD player.

When a used DVD-RW/DVD+RW is set

Data on the disc will be erased. If erasing is canceled, disc creation is canceled.

※

⒈
※

⒉

⒊

➡

※

➡

あ
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Selecting Videos and Writing onto Discs
You can select videos in the camcorder's recording media and create a DVD-Video disc.

Set a DVD to write to in the drive.

Close screens such as Explorer.

Connect the camcorder to the computer.

Select [CREATE DVD] in the camcorder menu.

The disc creation screen of the "MediaBrowser" will be displayed.

Step1 : Select candidates individually

Drag & drop the file(s) to write on a disc to the bottom half of the screen.

When videos you do not wish to write to disc are included

Select the video file and click [Deselect].

⒈
※

⒉

⒊

➡

⒋

の
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Click [Settings].

Check the disc creation settings and click [OK].

Menu Settings: Select menu design.

Writing Drive: Select the drive you set the disc.

⒌

⒍

•
•
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Disc size: Select the size of the disc set.

Disc Erase: Select the erasing method for using DVD-RW/DVD+RW that already contains data.

Quick Erase: Normally use this method.

Complete Erase: Select this method in cases such as erasing failure with Quick Erase.

Click [Next].

Step2 : Confirm

Check the content and click the [Start] button.

Number of Titles: One file is written as one title.

Number of discs: Displays the number of discs required for writing all files.

To change video files to write, click [Back] and go back to Step1.

To change settings such as disc size, click [Settings] and set again.

Writing will start.

•
•

•
•

⒎

⒏

•
•

※

※

➡
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Step3 : Write

When 2 or more discs are needed

If "Set a new disc" message appears, set a disc in a drive.

Up to 5 discs can be created in one operation.

Click [OK] at the finishing message.

If you click [Cancel] while writing, DVD-R/DVD+R disc becomes written and they cannot be used for 
writing new contents.

Created DVD can be played back on a DVD player.

の

※

⒐

※

➡
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Save Videos to the Computer

Saving the Videos in Selected Volume
You can select a volume from the camcorder's hard disk, SD Memory Card and save files to 
computer. Files already saved using "MediaBrowser" once will not be saved.

Connect the camcorder to the computer.

Select [BACK UP] in the camcorder menu.

"MediaBrowser" Backup screen will be displayed.

Step1 : Volume Selection

Select the volume where video file(s) you wish to save to the computer exist.

Click [Next].

⒈

⒉

➡

⒊

⒋
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Step2 : Confirm

Check the content and click the [Start] button.

Destination to save files: Location where video files are saved.

Number of scenes: Number of files saved to computer.

Necessary capacity: Capacity necessary for saving files.

Free space: Free space in saving destination.

If necessary capacity is bigger than free space

Files cannot be saved. Change the saving destination.

To change the destination, change the "Primary destination" in [Preferences...] in the [Settings] 
menu.

Saving will start.

⒌

•
•
•
•
あ

➡
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Step3 : Backup

Click [OK] at the finishing message.

Saved video files are displayed in "MediaBrowser" Library.

To save individual file

Select the camcorder in the Source pane, and drag & drop the file to save in [Show all] in the Li-
brary.

⒍

➡

の
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Export Videos to iTunes

Exporting
Video files with iTunes exporting settings configured on camcorder are converted for iPod 
supported format and added to iTunes.

Exporting to iTunes settings on camcorder is required beforehand. For how to set on camcorder, please refer 
to the camcorder instruction manual. For export, iTunes needs to be installed.

Connect the camcorder to the computer.

Press [EXPORT] button on the camcorder.

You can also select [EXPORT TO LIBRARY] in the camcorder menu.

"MediaBrowser" export screen will be displayed.

Step1 : Select candidates individually

Drag & drop the file(s) to export to the bottom half of the screen.

※

⒈

⒉
※

➡

⒊
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To select from all video files

Click [ ] to cancel filtering and all video files will be displayed.

When videos you do not wish to export are included in the bottom half

Select the video file and click [Deselect].

Click [Next].

Step2 : Confirm

Check the content and click the [Settings] button.

の

の

⒋

⒌
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Check the export settings and click [OK].

Destination to save converted files (for export to iTunes) : Select destination to save files.

Quality

High quality : Creates a file for iTunes in high quality.

Standard quality: For file size, etc., this option creates a file for iTunes in standard quality.

Click [Start].

Video file conversion and transfer to iTunes will start.

⒍

•
•

•
•

⒎

➡
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Step3 : Export

Click [OK] at the finishing message.

Exported video files are added to iTunes Playlist and reflected to iPod when you update your iPod 
next time.

⒏

➡
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Upload Videos to YouTube

Uploading
Video files with YouTube uploading settings configured on camcorder are converted for You-
Tube supported format and uploaded to YouTube.

Uploading to YouTube settings on camcorder is required beforehand. For how to set on camcorder, please 
refer to the camcorder instruction manual. Note that for uploading to YouTube, YouTube account and internet 
connection are required.

Connect the camcorder to the computer.

Press [UPLOAD] button on the camcorder.

You can also select [UPLOAD] in the camcorder menu.

"MediaBrowser" upload screen will be displayed.

Step1 : Select the candidates

Drag & drop the file(s) to upload to the bottom half of the screen.

※

⒈

⒉
※

➡

⒊
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To select from all video files

Click [ ] to cancel filtering and all video files will be displayed.

When videos you do not wish to upload are included in the bottom half

Select the video file and click [Deselect].

Click [Next].

Step2 : Enter account info

Enter YouTube account information and click [Next].

Username : Click [Add] and enter YouTube log-in username.

Password: Enter YouTube log-in password.

When logging in with Google account

Note that you need to enter full Google email address in the account input area.

Enter "*****(username)@gmail.com".

の

の

⒋

⒌

•
•
の



Using Videos Stored in Camcorder

��

Step3 : Enter info

Set video file information.

Description/Video Category/Tag/Private

The information entered here is applied to all files uploaded at the same time.

Adding a frame

Select the video file and click [Decomotion Settings].

Select a frame.

Click [Set].

⒍

※

の

①

②

③
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Click [Upload].

Movie conversion and uploading to YouTube will be started.

Step4 : Upload

Click [OK] at the finishing message.

Videos are added to YouTube.

⒎

➡

⒏

➡
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Check Video Contents
You can play back the videos stored in the camcorder by connecting your camcorder and the 
computer.

Entering Camcorder Name
Enter a name for connected camcorder. The name appears when the camcorder is con-
nected.

The same model camcorders appear with the same name.

Connect the camcorder to the computer.

Select [PLAYBACK ON PC] in the camcorder menu.

"MediaBrowser" browser screen will be displayed.

Right click the camcorder icon and select "Change camcorder name...".

A dialog box will be displayed.

※

⒈

⒉

➡

⒊

➡
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Enter a name for the camcorder and click [OK].

The camcorder is displayed with the set name.

Viewing Videos in List
You can switch view of video files.

Connect the camcorder to the computer.

Select [PLAYBACK ON PC] in the camcorder menu.

"MediaBrowser" browser screen will be displayed.

⒋

➡

⒈

⒉

➡
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Click [Camcorder].

Video files in camcorder are displayed.

Click [  ] / [  ].

Video files in camcorder are displayed in list.

⒊

➡

⒋

➡
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Checking Information of a Video File
Video file playback time, file formats and other details can be displayed.

Connect the camcorder to the computer.

Select [PLAYBACK ON PC] in the camcorder menu.

"MediaBrowser" browser screen will be displayed.

Click [Camcorder].

Video files in camcorder are displayed.

⒈

⒉

➡

⒊

➡
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Select a date the video file to check exists.

Select the video file and click [  ].

The selected video file details will be displayed.

⒋

⒌

➡
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Previewing

Connect the camcorder to the computer.

Select [PLAYBACK ON PC] in the camcorder menu.

"MediaBrowser" browser screen will be displayed.

Click [Camcorder].

Video files in camcorder are displayed.

⒈

⒉

➡

⒊

➡
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Select a date the video file to preview exists.

Double-click a video file.

Playback will start and video files in camcorder are played in sequence.

For previewing in full screen

Click [  ].
Double-click the video area to go back to original screen from full screen.

⒋

⒌

➡

の
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What You Can Do with Videos Stored in Com-
puter

"MediaBrowser" expands the use of videos stored in your computer.

Manage Videos
View in calendar style or create lists according to themes to organize videos.

For details, refer to "Manage Videos"(P. 47).

Preview Videos
"What is this video...?" Preview function will help you check the videos in times like this.

For details, refer to "Check Video Contents"(P. 67).

ォ

ォ
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Edit Videos
Store and edit videos that include unwanted scenes or videos of series of short segments.

Trimming editing which cuts off the unwanted scenes and file combination function are 
available. You can also set chapters for convenience when playback.

For details, refer to "Edit Videos"(P. 83).

Convert Videos for iTunes or YouTube
You can walk around with the recorded videos on your iPod, or share them on YouTube.

Export to iTunes
Video data is converted for iPod and automatically added to "iTunes".

For details, refer to "Export Videos to iTunes"(P. 95).

Upload to YouTube
Enter "YouTube" account information, and converted videos will be uploaded automatically.

For details, refer to "Link with YouTube"(P. 100).

ォ

•
ォ

•

ォ

iTunes
YouTube

iTunes
YouTube
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Save on a Disc
Created DVD-Video discs can be played back on a DVD player, and you can share the re-
corded videos with families and friends.

For details, refer to "Write Videos onto Discs"(P. 108).ォ
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Manage Videos

Browser Screen
All saved videos are handled in this Browser screen. The browser screen will be displayed 
when "MediaBrowser" starts up.

Basic Screen

Source pane

Locations that contain video files.

Browser pane

The list of the video files in the location you selected in the Source pane is displayed.

Contents are displayed in Calendar, Thumbnail, or List view.

1

2
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Source pane

Device

 Camcorder
Appears when a camcorder with built-in hard disk or  memory is connected. Displays a list of video files in the 
camcorder.

 SD Memory Card
Displays a list of video files in the SD Memory Card inserted in the camcorder.

 Removable Disk
Displays a list of video files in an external storage device.

Library

The Library is a place where all the video files used in "MediaBrowser" are stored.

 Calendar
Displays videos of specified year and month.

 User List
A list of video files collected from the Library by theme or any categories you wish.

 Smart List
A list of video files collected from the Library by specific conditions.

 Edited File

Displays video files such as a trimmed video.

1
•

•

•

2

•

•

•

•
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 Export List
Displays videos to be exported and already exported to iTunes.

 Upload to YouTube List

Displays videos to be uploaded and already uploaded to YouTube.

Operation buttons

 Add new User List button
Clicking this button creates a new List.

 Utility menu button
Displays available menu options depending on the item selected in the Source pane.

Browser pane

The list of the video files in the location you selected in the Source pane is displayed.

Switch Display

Switch view of video files.

 Thumbnail View
Displays a list of thumbnails of the videos.

•

•

3
•

•

1

•



Using Videos Stored in Computer

�0

 List View
Displays a list of thumbnails and information of videos.

 Calendar View

Displays videos for each month in Calendar view.

Thumbnail size change bar

Change the thumbnail size by dragging the slider.

[  ] button

Displays the information panel at the bottom of the Source pane, showing detailed information 
about the selected video file.

Display Filter

Filters videos to display.

File format filter

 Shows all files.

 Shows movies only.

 Shows still images only.

File purpose filter

 Cancels filtering.

 Displays only videos to upload to YouTube.

 Displays only videos to export to iTunes.

[Deselect] button

Cancels video file selections.

[Select all] button

Selects all video files in the Browser pane.

[Combine movies] button

Moves to Movie Combination screen to combine multiple video files.

[Movie Conversion] button

Moves to Movie Conversion screen to convert file format into movie sharing site.

•

•

2

3

4

•

•

5

6

7

8
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[Create Disc] button

Moves to Disc Creation screen to create DVD-Video disc.

[Export] button

Moves to Export screen to transfer videos to iTunes.

[YouTube] button

Moves to YouTube Upload screen to upload videos to YouTube.

9
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Screen when a Camcorder is Connected

Appears only when a camcorder is connected.

Browser pane

Information for each video file in the camcorder is displayed.

Symbols for the file status

 (Imported mark)

Among the video files stored in the camcorder, the "Imported mark" is displayed for video files 
which have already been imported to the Library.

[Backup] button

Moves to Backup screen to save videos to computer.

1
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Browser Pane Views

Calendar View (monthly)

[<] (previous year) button

Moves to previous year's calendar. Disabled when there is no videos recorded in the previous 
year of the currently displayed.

[1]-[12] month button

Buttons of months with recorded videos are enabled.

[>] (next year) button

Moves to next year's calendar. Disabled when there is no videos recorded in the following year 
of the currently displayed.

Thumbnails displayed

Put the cursor on the thumbnail and after a while, thumbnail list of videos recorded on the day 
will be displayed.

Click to view the calendar of the recording day.

1
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Calendar View (daily)

 (back to Monthly view) button

Goes back to monthly calendar.

[<] (previous week) button

Moves to the calendar of the week containing videos recorded prior to the currently displayed 
videos.

Date button

Buttons of dates with recorded videos are enabled.

[>] (next week) button

Moves to the calendar of the week containing videos recorded after the currently displayed 
videos.

Time

Displays thumbnails of the videos in the column of recording time.

Memo

You can enter any memo about the time you recorded the video.
You cannot enter memo when the camcorder is selected in the Source pane.
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Thumbnail View

Displays thumbnails and titles of the videos.

To change the thumbnail size

You can change the thumbnail size by dragging the thumbnail size change bar at the top of the 
browser pane.

What do the icons on the thumbnails mean?

Video type

 Movie file

 Still image file

Process type

 Disc created file

 File with exporting to iTunes settings configured on camcorder

 File exported to iTunes

 File with uploading to YouTube settings configured on camcorder

 File uploaded to YouTube

Symbols for the file status

 (Cannot find this file)

The file was added to the Library in the past, but it cannot be found as the file location has been 
changed or the file has been deleted.

の
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List View

Following items are displayed for each video file.
File status/Thumbnail/Title/Video format/Audio format/Image size/System bit rate/

Playback time/File size/Date recorded/Date added/Date modified/Date edited/My rating/Play count

Symbols for the file status

 (Cannot find this file)

The file was added to the Library in the past, but it cannot be found as the file location has been 
changed or the file has been deleted.

 (Cannot move this file)

The file cannot be moved to the location when this symbol is displayed while drag & drop.

To select View Options for video files

To change View Options, select [Show View Options...] in the [Window] menu, and set the options 
you want to display. Note that the file status and title cannot be hidden.

の
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File Information Panel

When you select a video file and click the [  ] button, detailed information will be dis-
played.

Click [  ] again to close the File Information panel.

Details tab

"System bit rate" and "Video bitrate" may be 
different from bitrates on camcorder.

※
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Options tab

Thumbnail

Displays a thumbnail of the video.Change the thumbnail by dragging the slider.

The thumbnail that appears on the menu screen of the created disc is the beginning scene of each video file.

Title

You can change the title of the videos in the Library. The name you set here appears on the 
menu screen of the created disc.

My rating

You rank your favorite video files. This rating can be used as one of the rules for Smart Lists. 
Click or drag on the stars to increase/decrease the number of stars.

When minimizing My rating

Dragging the star to the left end minimizes the rating.

Comments

You can enter any comments about the video file.

1
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Preferences Screen

The screen is displayed when you select [Preferences...] in the [Settings] menu.

Workspace

Set a place for the MediaBrowser workspace used when editing movies or creating discs. A 
volume with most free space is selected as default. Volumes which you may not write to will 
not be displayed.

Library destination settings

Set two locations to save Library contents.

Primary destination: Files are saved until all the free space is used in this location.
[Everio MediaBrowser] folder in the [My Video]/[Video] folder ([My Document] folder if [My Video] folder does not 
exist) is set as default.

Do not delete the original destination folder after you change the Library destination. The new Library destination will only 
contain files that you are going to add to the Library after the change.

Destination: Files are saved in this location when there is no space in Primary destination.

Switch destinations : Click to switch the Primary destination and the destination.

1
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Reset all Imported Marks

Click [Reset] if you want to reset all the Imported marks (P. 52).

Video System

Select the video system when creating a disc or exporting files in a different format.

Beginning of Week

You can select between Sunday and Monday to display on the left in Calendar view.
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Preview Screen
Double-click a video file and the screen appears.

Elapsed time

Shows the current playback position.

Playback slider (seek)

Shows the current playback position. You can also drag the slider to set where to start playing.

  button

Plays back/pauses video. During playback, the button will appear as Pause button.

Frame Skip button

 : Moves to previous frame.

 : Moves to next frame.

Chapter Skip button

 : Moves to previous chapter.

 : Moves to next chapter.
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File Skip button

 : Jumps to the top of the video file you are playing back.
When the playback point is already at the top of the video file, it jumps to the top of the previous video file.

 : Jumps to the top of next video file.

  button

Mutes/Restores the volume.

Volume level

Adjusts the volume of the video you are playing.

  button

Shows preview in full screen. Click to pause/playback and double click to play back in original 
screen size.

  button

Saves a scene of a movie as a still image

Remaining time

Displays the remaining time of the video during playback.

[Set Chapters] button

Displays the chapter setting screen and sets chapters in the video being played back.

[Movie Edit] button

Displays the movie edit screen and trim the video being played back.

[Finish playback] button

Quits playback and returns to the browser screen.
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What's Library?
The Library is a place where all the video files used in "MediaBrowser" are stored. All saved 
videos are managed in the Library.

Library and Lists

The Library is a place where all the video files used in "MediaBrowser" are stored.A list is used 
to group videos with a common theme. You can create multiple lists and sort the videos in the 
Library according to your preferences. 

Videos added to a list do not move to the list but remain in the Library. Lists are just a conve-
nient way for organizing and displaying videos that share a common theme.

Adding Videos to the Library

Adding Videos in the Camcorder

Add videos in camcorder connected to computer to the Library.

Select the camcorder in the Source pane.

Click [Backup].

⒈

⒉
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Step1 : Volume Selection

Select the volume where video file(s) you wish to save to the computer exist.

Click [Next].

Step2 : Confirm

Check the content and click [Start].

Destination to save files: Location where video files are saved.

Number of scenes: Number of files saved to computer.

⒊

⒋

⒌
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Necessary capacity: Capacity necessary for saving files.

Free space: Free space in saving destination.

If necessary capacity is bigger than free space

Files cannot be saved. Change the saving destination.

To change the destination, change the "Primary destination" in [Preferences...] in the [Settings] 
menu.

Saving will start.

Step3 : Backup

Click [OK] at the finishing message.

Saved video files are displayed in "MediaBrowser" Library.

•
•
あ

➡

⒍

➡



Using Videos Stored in Computer

��

Adding Files in the Computer to the Library

Select [Add Files to Library...] in the [File] menu.

Select [Add Folder to Library...] if you wish to add a whole folder.

Select a file you wish to add and click [Open].

The file is added to the Library.

Adding by drag & drop.

You can also add files/folders to the Library by drag & drop. In "Explorer", open the folder contain-
ing the video file or folder you wish to add and drag & drop to the browser screen.

It is not possible to drag & drop from removable disks.

⒈
※
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Handling the files added to the Library

"MediaBrowser" cannot find files if, for example, the files are deleted in "Explorer" after being add-
ed to the Library. Do not delete or move the video files you use in "MediaBrowser".

If you are using removable medias such as a USB memory, save the video files to the computer in 
advance, before adding them to the Library.

About files in camcorder

Selecting files in camcorder in file selection dialog will only add the link information and not copy 
the files themselves. Added files become un-usable if you disconnect or initialize camcorder.

To add video files in camcorder to the Library, refer to "Save Videos to Computer" (P. 23).

Checking Video Contents
Viewing Videos in List

Select [Show all] and click [  ] / [  ].

To select View Options for video files

To change View Options, select [Show View Options...] in the [Window] menu, and set the options 
you want to display.

Note that the file status and title cannot be hidden.

To change the thumbnail size

You can change the thumbnail size by dragging the line between the item headings [Thumbnail] 
and [Title] in the browser pane.

あ
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Checking Information of a Video File

Video file playback time, file formats and other details can be displayed and previewed.

Select a list the video file is contained and select the video file.

Click [  ].

The selected video file details will be displayed.

Click the [Option] tab, and file thumbnail display or title can be changed and comment can be entered.

⒈
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Double-click a video file you wish to preview.

Playback will be started and video files in the selected list are played in sequence.

For previewing in full screen

Click [  ].
Double-click the video area to go back to original screen from full screen.

⒊

➡

の



Using Videos Stored in Computer

�0

Organize Videos
When the number of files in the Library is increased, create lists for easy file search.

To organize video files

It is recommended to switch the browser pane view to List view.

Click [  ] to switch to List view.

Differences between User Lists and Smart Lists
When you have a large number of video files in "MediaBrowser" and handling them be-
comes difficult, organizing files can be made easier by creating Lists by theme or any other 
category you prefer. There are two types of Lists you can create with "MediaBrowser": regu-
lar User List and Smart List.

User List

"User List" is a any collection of video files you like, just as a photo album.

For example, if you create an List "Birthday party", you can select and add video files related 
to the birthday party manually to that List. Then, you can play back the video files in sequence 
when you want to watch the birthday party videos, or create a disc from the List.

Smart List

"Smart List" collects video files automatically, using the electronic data characteristics. When 
you set a the rules for the Smart List, video files that match the criteria are collected automati-
cally.

For example, if you create a Smart List "April 2008" with the criteria "Videos recorded in April 
2008", all video files recorded on the specified date are added automatically.

の
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Creating a List by Collecting Favorite Video Files

Click [  ].

Enter the list name and click [OK].

A new List is created in the Source pane.

⒈

⒉
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Click [Show all].

Drag & drop the file(s) to the created List.

The selected video file(s) are added to the List.

To select multiple files

To select contiguous files, hold down the [Shift] key and select files, or to select non-contiguous 
files, hold down the [Ctrl] key and select files.

Sorting video files in the List

You can arrange files by clicking the item heading or dragging & dropping files.

⒊

⒋
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Organizing Multiple Videos Automatically by Set-
ting Criteria (Smart List Creation)

Select [New Smart List...] in the [File] menu.

Set the criteria and click [OK].

If you wish to add rule(s), click [  ] on the right and set the rule. If you wish to remove rule(s) after 
setting up multiple rules, click [  ].

Setting up rules in Smart List

You can set up to 10 rules for one Smart List.

⒈

⒉

の



Using Videos Stored in Computer

�4

Enter the list name and click [OK].

All the files that match the criteria will be added automatically to the Smart List.

Changing the criteria

If you wish to change the rule(s) afterwards, right-click the Smart List you wish to change and se-

lect [Edit Smart List...] from the menu displayed.

Deleting File/List

Select a file/List to delete.

⒊
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Select [Delete] in the [Edit] menu.

A confirmation dialog will be displayed.

When deleting files from the Library

If you wish to delete the file(s) from the computer, select [Delete completely]. If you wish to remove 
the display of the file from the Library only, select [Keep files].

If you delete file(s) from a List...

The file(s) are removed from the List, but they remain in the Library. Files cannot be deleted from 
Smart Lists.

If you delete a List...

The List will be removed, but the video files in the deleted List will remain in the Library.

⒉
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Additional Features of the Library

Sorting Video Files

Arranging items in ascending/descending order

Click [  ] of the switch view buttons.

Click an item heading in the browser pane.

Video files are arranged in ascending/descending order.

Files cannot be sorted by thumbnail aspect ratio, video format or system bitrate.

⒈

⒉
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Arranging by drag & drop

Click [  ].

Select a video file and drag to the location you wish to move the file to.

In Smart List

Files cannot be sorted by drag & drop. Files can be arranged by clicking the item heading.

⒈
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Changing Titles

Select the video file and click [  ].

The File Information panel will be displayed.

Click the [Option] tab and enter the new file name in the [Title].

Click [  ] to close the File Information panel.

⒈
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Saving a Scene of a Movie as a Still Image

Double-click a video file.

The preview screen will be displayed.

Display the scene to save as a still image.

⒈
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Click [  ].

The saved still image is displayed in the Library.

Destination to save still image

The image is saved as "movie title_Capture.jpg" in the following destination.

.../[Primary destination] folder set in Preferences/Capture/YYMMDD/

⒊
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Saving Video Files in a Folder
You can copy and save video files you wish to use in applications other than "MediaBrows-
er" in a location you prefer.

Select a video file and select [Save...] in the [File] menu.

To select multiple files

To select contiguous files, hold down the [Shift] key and select files, or to select non-contiguous files, 
hold down the [Ctrl] key and select files.

Set a location and filename and click [Save].

⒈
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Destination to save files: To change the destination, click the [Browse...] button and select the desti-
nation.

Filename: Use title name: Save using the video title as the filename.

Enter filename: Enter a filename of your choice. The extension of the file (.mpg, etc) is added auto-
matically. When multiple files are selected, they are saved as the numbered filenames such as "File-
name_1", "Filename_2".

The copy of the video file is saved in the specified destination.➡
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Edit Videos

Movie Edit Screen

Elapsed time

Shows the current playback position.

Playback slider (seek)

You can drag the slider to set where to start playing.

IN-point slider/OUT-point slider

Slider to specify the range you wish to save as a new file.Specifies starting point with IN-point 
and end point with OUT-point.

Multiple ranges cannot be specified.

Remaining time

Remaining of the playback time. Displays the remaining time from the IN-point/OUT-point slid-
er.
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  button

Playback/Pause video.
During playback, the button will appear as Pause button.

Frame Skip

 : Moves to previous frame.

 : Moves to next frame.

Chapter Skip

 : Moves to previous chapter.

 : Moves to next chapter.

  button

Mutes/Restores the volume.

Volume level

Adjusts the volume of the video you are playing.

[Set] button

Cuts out the specified range and creates a new file.
The original file will not be changed.

[Finish movie edit] button

Quits movie edit and returns to the preview screen.
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Chapter Settings Screen

Elapsed time

Shows the current playback position.

Playback slider (seek)

Shows the current playback position.

Remaining time

Displays the remaining time of the video during playback.

Chapter list

Thumbnails of active chapters are displayed.You can set up to 20 chapters for one video file.

  button

Playback/Pause video.
During playback, the button will appear as Pause button.
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Frame Skip

 : Moves to previous frame.

 : Moves to next frame.

Chapter Skip

 : Moves to previous chapter.

 : Moves to next chapter.

  button

Mutes/Restores the volume.

Volume level

Adjusts the volume of the video file.

[Set Chapters] button

Sets a chapter at the scene currently displayed.

[Delete current chapter] button

Cancels the chapter setting selected in the chapter list.

[Delete all chapters] button

Cancels the all chapter setting in the chapter list.

[Save and finish chapter setting] button

Applies chapter setting and the screen goes back to the preview screen.

[Cancel] button

Does not apply chapter setting and the screen goes back to the preview screen.
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Combining Multiple Video Files
Files with same Video format, Image size, Aspect ratio, Video system and Frame rate can 
be combined, but the total playback time must be within 4 hours after combining.

Select a list the video file to combine exists and click [Combine movies].

Step1 : Select the candidates

Drag & drop the file(s) to combine to the bottom half of the screen.

Click [Next].

⒈
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Step2 : Confirm

Click [Start].

To change video files to combine, click [Back] and go back to Step1.

Step3 : Combine

Click [OK] at the finishing message.

The combined video file is added to the Library.

Files before and after combination

The original file is not changed and a new file is saved as "movie title_Combine.mbv" in the follow-
ing destination.

.../[Primary destination] folder set in Preferences/Combine/YYMMDD/

⒋
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Cutting Out a Necessary Scene (Trimming)

Double-click a video file you wish to edit.

The preview screen will be displayed.

Click [Movie Edit].

The trimming screen will be displayed.

⒈
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Move the IN-point slider to the start point of the range you wish to save as a new 
file.

Move the OUT-point slider to the end point of the range.

 (to previous frame),  (next frame) buttons to move frame by frame.

⒊
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Click [Set].

The edited file is added to the Library.

If you selected a file from a List, the same edited file is added to the List as well.

Click [Finish movie edit].

The screen goes back to the preview screen.

Files before and after editing

The original file is not changed and a new file is saved as "movie title_Edit.mbv" in the following 
destination.

.../[Primary destination] folder set in Preferences/Edit/YYMMDD/

⒌
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Setting Chapters on a Video File

Double-click a video file you wish to edit.

The preview screen will be displayed.

Click the [Set Chapters] button.

The chapter settings screen will be displayed.

⒈
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Display the scene where you want to set a chapter using buttons or playback slider.

Click the [Set Chapters] button.

When setting two or more chapters, leave an interval of more than 3 seconds between chapters.

The thumbnail of the scene the chapter is set is added to the chapter list.

⒊
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Repeat step 3 and 4 to set additional chapters as necessary.

You can set 20 chapters at maximum for one video file.

Click [Save and finish chapter setting] button.

Chapters are set and the screen goes back to the preview screen.

If you set chapters

Timing of set chapters can be checked on the playback bar in the preview screen.

When you create a disc, you can skip back and forth using chapter skip buttons.

⒌
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Export Videos to iTunes
You can transfer and add videos saved in the computer to iTunes. For export, iTunes needs to 
be installed.

Exporting
Video files set for exporting to iTunes on camcorder are put into "To be exported" list. You 
can also select videos in the computer and export.

Select "To be exported" list.

If you wish to export videos not in the "To be exported" list, select the list that contains the file you 
wish to export.

⒈
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Click [Export].

Export screen will be displayed.

Step1 : Select the candidates

Select [Select files individually].

Click [Next].

⒉

➡

⒊

⒋



Using Videos Stored in Computer

��

Step2 : Select candidates individually

Drag & drop the file(s) to transfer to the bottom half of the screen.

When videos you do not wish to export are included in the bottom half

Select the video file and click [Deselect].

Click [Next].

Step3 : Confirm

Click [Settings].

⒌
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Check the export settings and click [OK].

Destination to save converted files (for export to iTunes) : Select destination to save files.

Quality

High quality: Creates a file for iTunes in high quality.

Standard quality: For file size, etc., this option creates a file for iTunes in standard quality.

Click [Start].

Video file conversion and transfer to iTunes will start.

⒏
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Step4 : Export

Click [OK] at the finishing message.

Exported video files are added to iTunes Playlist and reflected to iPod when you update your iPod next 
time.

➡
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Link with YouTube
You can convert videos for YouTube and upload.

Uploading
Video files set for uploading to YouTube on camcorder are put into "To be uploaded" list. 
You can also select videos in the computer and upload.

Note that YouTube account and internet connection are required for uploading to YouTube.

Select "To be uploaded" list.

If you wish to upload videos not in the "To be uploaded" list, select the list that contains the file you 
wish to upload.

※
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Click [YouTube].

YouTube upload screen will be displayed.

Step1 : Select the candidates

Drag & drop the file(s) to upload to the bottom half of the screen.

When videos you do not wish to upload are included in the bottom half

Select the video file and click [Deselect].

Click [Next].

⒉
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Step2 : Enter account info

Enter YouTube account information and click [Next].

Username : Click [Add] and enter YouTube log-in username.

Password: Enter YouTube log-in password.

When logging in with Google account

Note that you need to enter full Google email address in the account input area.

Enter "*****(username)@gmail.com".

⒌
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Step3 : Enter info

Set video file information.

Description/Video Category/Tag/Private

The information entered here is applied to all files uploaded at the same time.

Enjoy more!  -Adding a frame -

Select the video file and click [Decomotion Settings].

Select a frame.

Click [Set].

⒍
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Click [Upload].

Movie conversion and uploading to YouTube will be started.

Step4 : Upload

Click [OK] at the finishing message.

The uploaded video file(s) are added to the "Uploaded" list.

⒎
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Converting Videos for Movie Sharing Site
You can convert videos to WMV format for uploading to movie sharing site other than You-
Tube or playing back on portable media players.

Depending on the sites or players, converted files may not be played back.

Select a list the video file to convert exists and click [Movie Conversion].

Movie Conversion screen will be displayed.

Step1 : Select the candidates

Drag & drop the file(s) to convert to the bottom half of the screen.

※

⒈

➡

⒉



Using Videos Stored in Computer

10�

When videos you do not wish to convert are included in the bottom half

Select the video file and click [Deselect].

Click [Next].

Step2 : Confirm

Click [Settings].

Select saving destination of the converted file and click [OK].

の
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Click [Start].

Conversion will start.

Step3 : Movie Conversion

Click [OK] at the finishing message.

The copy of the video file is saved in the specified destination.

⒍
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Write Videos onto Discs

Writing Discs
You can select videos in the computer and create a DVD-Video disc.

Set a DVD to write to in the drive.

Close screens such as Explorer.

Select a list the video file to write to DVD exists.

⒈
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Click [Create Disc].

The disc creation screen will be displayed.

Step1 : Select the candidates

Select [Select files individually].

To write all files displayed to a disc, select "Select all files displayed".

Click [Next].

⒊

➡

⒋

※

⒌



Using Videos Stored in Computer

110

Step2 : Select candidates individually

Drag & drop the file(s) to write on a disc to the bottom half of the screen.

Changing Titles

Select the file to change name and click [  ], then open [Options] tab. Enter a name in the [Title] 
text box to change the title name.

When videos you do not wish to write to disc are included

Select the video file and click [Deselect].

Click [Settings].
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Check the disc creation settings and click [OK].

Writing drive: Select the drive you set the disc.

Disc size: Select the size of the disc set.

Disc erase: Select the erasing method for using DVD-RW/DVD+RW that already contains data.

Click [Next].

⒏
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Step3 : Menu Settings

Set the menu screen.

Enter title.

Select the design of the menu screen of the disc.

Click [Next].

Step4 : Confirm

Click [Start].

Writing will start.

①
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Step5 : Write

 Click [OK] at the finishing message.

If you click [Cancel] while writing, DVD-R/DVD+R disc becomes written and they cannot be used for 
writing new contents.

Created DVD can be played back on a DVD player.

※

➡



Troubleshooting
This chapter explains frequently asked questions about "MediaBrowser" and includes User Sup-
port Centers in your region.
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Frequently Asked Question

Preparation

The DVD drive cannot be recognized after installing "MediaBrowser".

At restarting CD/DVD device driver files are overwritten after installing our product. This opera-
tion may have failed or the driver file may be conflicting with other driver files of other company.

If possible, remove the writing software of other company and reinstall "MediaBrowser".

"MediaBrowser" does not work properly.

Exit "MediaBrowser" and restart the computer.

My camcorder is not recognized by the computer.

Check the following:

Have you installed "MediaBrowser"?

Have you turned on the camcorder?

Is the camcorder powered using the AC adapter?

Is the USB cable connected to the computer properly?
If the USB cable is connected properly and is not recognized, connect to another USB port of the com-
puter.

Disconnect the USB cable, then restart the computer and reconnect the camcorder with the com-
puter in the correct procedure.

Disconnect any USB devices other than the camcorder, keyboard, and mouse.

If the camcorder is connected via a USB hub, connect the camcorder directly to the computer.

If any resident software is installed, exit and connect the camcorder.

"MediaBrowser" does not fit in the computer screen.

This occurs when screen resolution is below 800 x 600. Select resolution above 1024x768 in 
Screen properties.

What are the supported DVDs?

Depends on the drive you have, but "MediaBrowser" supports DVD-R, DVD+R, DVD-RW, 
DVD-R DL, DVD+R DL, and DVD+RW. DVD-RAM discs are not supported.
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Can I edit videos?

Yes, trimming and file combining are supported. To trim videos, select [Movie Edit] in the pre-
view screen.

I exited from the resident application by mistake.

You can start up from [Start] menu-[All Programs]-[Starup]-[MBCameraMonitor].

If unsure, restart the computer, and it will be started automatically.

Saving on the Computer

I can't transfer videos from the camcorder to the computer.

Try another USB port of the computer. For desktop computers, try the USB port on the back.

It takes a long time to import video from the camcorder to the computer.

It takes a long time when importing many files in one batch or importing a large video file.

When importing, close all software other than "MediaBrowser".

A message "Not enough disk space" appears.

Free space at least twice the volume of data to be written on the disc is required for creating a 
disc. Increase the free space in work disk in the computer or change the work disk in Prefer-
ence screen (P. 59).

Where in the computer is the video saved?

Location you specify in "Setting" in the Backup screen.

The following location is selected as default.

[Everio MediaBrowser] folder in the [My Video]/[Video] folder 

([My Document] folder if [My Video] folder does not exist)
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Importing and Organizing Videos (Library)

 (Cannot find this file) appears.

"MediaBrowser" cannot find files if, for example, the files are deleted in "Explorer" after being 
added to the Library. Do not delete or move the video files you use in "MediaBrowser". In case 
you deleted the file, delete from the Library as well, and add the file again to the Library.

If you are using removable medias such as a USB memory, save the video files to the computer in ad-
vance, before adding them to the Library.

I want to erase all (Imported mark).

Select [Preferences...] P. 59  from the [Settings] menu and reset.

I can't arrange the order of the videos in a Smart List.

In Smart Lists, files cannot be sorted by drag & drop.

Files cannot be added to Smart Lists.

Files cannot be added to Smart Lists manually. The video files that match the criteria are col-
lected and added automatically.

I want to close the File Information panel.

Click [  ] on the top right of the panel to close the File Information panel.

I cannot export to iTunes

"iTunes" is required to transfer files to the iPod. You can download "iTunes" from the Web site 
of Apple Inc.

I cannot upload to YouTube

Note that for uploading to YouTube, YouTube account is required. Create an account.

I want to change titles.

For changing title name, select a video file, click [  ] and change title in the [Options] tab 
of the File Information panel.

You cannot change filenames in "MediaBrowser", but you can change in "Explorer".
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Storing Videos

Drives are not detected.

Drives may not be detected if the computer is not restarted after installing "MediaBrowser".

Drives may not be detected if writing software (packet writing) is installed.

It takes a long time to write a disc.

Processing speed may vary depending on your computer's configuration, for example CPU 
performance and memory capacity, or on the content of the video.

I can't write on an 8cm disc.

8cm discs are not supported.

I can't write on a DVD disc.

Check the following.

Is the disc supported by "MediaBrowser"? (P. 10)

Does the writing drive support the disc? Check the disc types supported by your computer's drive.

I cannot proceed with the error "Not enough disk space for the workspace". 

14GB or more space is required in the workspace specified. For writing to dual layer disc, 
28GB or more is required. To change the workspace, specify the workspace in [Preferences...] 
in the [Settings] menu.

What is the size of movie file saved on a DVD?

Total capacity is 4.7GB. About 1 hour video file can be stored.

How many movie files can be saved on a DVD?

You can write up to 99 titles. When total capacity exceeds 4.7GB, writing cannot be performed 
even the number of titles is less than 99.
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Can I add contents to a DVD?

Adding contents is not supported. Writing in DVD-Video format after erasing contents only is 
supported.

Can I write on a CD?

Only writing to DVD is supported. For writing to CD, use other writing software.

Can I write still images on a DVD?

Writing still images to a disc is not supported.

There is some capacity left in the created disc.

If the recorded data cannot fit into one disc, writing to another disc is performed and this may 
occur. This is not avoidable.

Writing the disc fails when using rewritable DVDs after erasing the recorded 
data.

Disc creation may fail if the data on a rewritable disc has been erased using software other 
than "MediaBrowser". When using a recorded rewritable disc, insert the disc as it is and erase 
the recorded data using the writing options of "MediaBrowser".

I want to change the menu title.

You should enter the menu title before writing a disc.

Changing Titles

Select the file to change name and click [  ], then open [Options] tab. Enter a name in the [Title] text 
box to change the title name.

DIRECT DVD

I want to create a DVD with contents I already saved to DVD once.

Once you created a DVD using Direct DVD, data is labeled as written on camcorder, and can-
not be saved on DVD.

You can save files in computer and create a DVD-Video disc. 
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Can I create a DVD with DIRECT DVD using contents I saved to computer 
once?

You can save onto DVD with contents not used in Direct DVD before. Files already used for 
DVD creation once cannot be saved.

Others

I can't exit "MediaBrowser".

Close all dialog boxes and setting screens before exiting.

Video files are not displayed.

If  they actually exist but not displayed in the browser pane, check if the view is filtered. Click 
[  ] to cancel filtering.
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MediaBrowser Support Information
PIXELA CORPORATION offers a support service for registered users. For technical inquiries 
about this product, please contact our User Support Center in your region.

PIXELA CORPORATION User Support Center

USA and Canada

+1-800-458-4029 (toll-free)

Language: English

Europe (UK, Germany, France, and Spain)

+800-1532-4865 (toll-free)

Language: English, German, French, Spanish

Other Countries in Europe

+44-1489-564-764

Language: English, German, French, Spanish, Italian, Dutch

Asia (Philippines)

+63-2-438-0090

Language: English

China

+86-21-5385-3786

Language: Chinese
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Homepage
Please check the PIXELA Web site for latest information and downloading.

http://www.pixela.co.jp/oem/jvc/e/

http://www.pixela.co.jp/oem/jvc/e/

	Introduction
	About The Software Guide
	Before Using MediaBrowser
	Preparation
	What You Can Do with MediaBrowser

	Using Videos Stored in Camcorder
	What you can do with the camcorder connected
	Write Videos onto Discs
	Save Videos to the Computer
	Export Videos to iTunes
	Upload Videos to YouTube
	Check Video Contents

	Using Videos Stored in Computer
	What You Can Do with Videos Stored in Computer
	Manage Videos
	Organize Videos
	Additional Features of the Library
	Edit Videos
	Export Videos to iTunes
	Link with YouTube
	Write Videos onto Discs

	Troubleshooting
	Frequently Asked Question
	MediaBrowser Support Information


